TrakkStar Tutorial
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This tutorial outlines the steps necessary for some of the more
common computer aided scanning activities. You may wish to
PRINT this document now, so you can follow along as you explore
TrakkStar. If you haven't worked with TrakkStar before, it is
STRONGLY recommended that you follow this tutorial from start to
finish. Doing this will give you a guided tour through most of the
main TrakkStar features.

At the end of this tutorial are the answers to some frequently asked
questions. If you get an error message from TrakkStar during any of
these examples, refer to the frequently asked questions section, or
the radio troubleshooting section of the on-line manual.

Asyou follow through this tutorial, you may see that some or al of the files and
settings mentioned here are already set in the program. When TrakkStar is
installed, a number of sample files are copied to your hard disk, and the initial
settings are preset to use these files.
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Scanning Conventional Frequencies

In this example you will scan some of the sample scanning files provided with TrakkStar.
This section assumes that you are using the standard display, which is the default the first
time you use the program.

1. In the TrakkStar program group, double click on the icon for the radio you installed.

2. If you just installed TrakkStar, scanning should start automatically using some of the
samplefiles. If it does start scanning, you may skip to step 8.

3. Click on the File menu, then click on Scan List.
4. The Scan List window should appear on the screen:

Scan List - Untitled I
Title:

Description:

Click on the hne number of the entry you wizh to change.
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Double click in the white area below either TYPE or FILENAME.



5. The Scan List Entry dialog box should appear on the screen.

Scan List Entry #1

~Type: —————  Logging:

" Group [~ ASCI

" Search Bange [ Journal Clear I
Edit |
Mame:

Description:

Click the Group radio button. Thisislocated in the top left section
of the screen, which istitled Type:.



6. A standard Windows file dialog will appear with some .SVG files listed:

Select Group File |
File name: Folders:
|‘.swg c:\trakstar

Cancel |
actvyham.zwg - ek -
h:jdtrk.swg 5 trakstar Hel
cd.swg B3 tedist? i]

fire_swg
gmrs. swg
iting_swg
ken.swg w
maritime_swg _ﬂ

Lizt files of type: Drives:
!Emups['_SWE] _‘j I =) c: ms-dos_b :_I

These files are TrakkStar group files, which contain lists of frequencies. The fileslisted
are the samples included with TrakkStar (unless you have aready created some yourself.)

7. Select FIRE.SWG and click on OK. Now click on DONE to exit the Scan List Entry
dialog. The FIRE.SWG should now be listed in the scan list. The Scan List window has 25
dotsinit, and each dot can have either a Group or Range file. Thisis significant, since it
means that you can combine up to 25 different frequency lists or search ranges and scan
them together.

8. Close the Scan List window by clicking on the OK button.

9. You should now have the scanning status window on your screen.

= STOPPED - ARS000-1 - F1 for ... M= E3

File Optionz  Help
Freq: | | 1D: | |
Name: | |

Mode:[ | s

DTMF: | |
Signal: | |
Logging: | |
Pause Scan Lock Exit
ID Hold | Add ID | Lock ID Edit

When asignal is received the frequency and other information is displayed here. Note that
the TrakkStar sample files may not have frequencies that are active in your area, so don't
expect to hear too much (yet).



10. Click on the Options menu, and then click on Tactical display.

Freq:| | 1oz [
Mame:|

DTMF:[
Signal:[
Logging:|
Pause Scan Lock Exit
1D Hold | AddID | Lock ID Edit

File View |/ Options || Reset

#56.4875M 8944 5107 EMS to—
860.9875M 4240 S069 Dawie (—
856. 48756 8944 5110 EMS to
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g6F.7126M 272 5024 Ch. 24
B52. 7375 4784 3063 Chi.
860.9875M 4784 S062 Ch. 20
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#59.7126M 8880 S063 EMS to
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Thiswill change the display to alarge version, which displays the channel information,
and the activity log.

11. Press the View button to change back to the standard display if you want to conserve
screen space.

12. Press the Exit button if you want to stop scanning, and exit the program.



Sear ching a Range of Frequenciesfor Activity

This section assumes that you have already started the TrakkSar program, and are at the
main scanning window.

1. Click on the File menu, then click on Scan List.
2. The Scan List window should appear on the screen:

Scan List - Untitled ]
Title:

Descnption:

Chck on the ine number of the entry you wizh to change.
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If you want to add to the existing group that is aready set up from the previous section,
double click in the blank white area below the existing group, in either the TY PE or
FILENAME column. Thiswill add a second scan group (or range).

To replace an existing group (or range), simply double click on an existing type, or
filename, in the white area, in either the TYPE or FILENAME column.



3. The Scan List Entry dialog box should appear on the screen.

Scan List Entry #1

~Type:————— ~ Logging:
" Group [ ASCI
" Search Range [ Journal Clear I
File
Mame: AL
Help
Description:

Click the Sear ch Range radio button. Thisislocated in the top left section of the
screen, which istitled Type:.

A standard Windows file dialog will appear with some .SAR files listed:

Select Search Range |
File name: Folders:

|’. W c:trakstar

— Cancel |
aviation_swr - {3 o\ A

baggage. swr trakstar

GMIs: SWI. % tzdist? ﬁl
ham220_swr

hamZmetr_swr —
ham440_swr

Marnine._swr x

media. swr _ﬂ
Lizt files of type: Drives:
!Hanges[‘_SWH] _ﬂ I =) c: msz-dos_b _:_l New |

These files are TrakkStar search ranges, and contain frequency bands. The fileslisted are
the samples included with TrakkStar (unless you have aready created some yourself.)




4. Select AVIATION.SAR and click on OK, then click on DONE to exit the Scan List
Entry dialog. TrakkStar will now include the aviation band in the scan list.

7. Close the Scan List window by clicking on the OK button.

8. You should now have the scanning status window on your screen.

= STOPPED - ARS000-1 - F1 for ... [[=]E3

File DOptionz Help
Freq: | | 1D: | |
Mame: | |

Mode:[ | A |

DTMF: | |
Signal: | |
Logging: | |
Pause Scan Lock Exit
ID Hold | Add ID | LockID Edit

If you added to the scan list, TrakkStar will
be scanning two files, the FIRE group and
the AVIATION search range. Otherwise, it
will just be scanning the AVIATION search range.



Editing a Search Range

This section will explain how to find out what frequencies are being scanned within an
existing Search Range.

There are two different ways to view the details about a search range from within
TrakkStar, depending upon what screen you are on at the moment.

From the Scan List Entry window:

1. Pressthe Edit button.
2. The Range Quick Edit window will appear:

Range Quick Edit - ARS000 |
Mame: Frequency:
|Aviation Band - VHF | 123.3000
Stark: Stop: Step:
| 119.0000 | 136.0000 | s0.000
Mode: Attenuation: Uszer ID: Signal min: Signal max:
EC ) (R N =
Lockout: Delay time: Dwell time: Time lmit: Alarm:
Scan =] |0 o |5 o
Comments:
Cancel Help

3. Thiswindow contains the properties for the selected Search Range.
4. Make any changes you wish, and press OK.
5. Any changes you have made will be reflected immediately.



From the Tactical Display:

1. Right click on the Search Range on the right side of the display.

2. The Range Quick Edit window will appear:

Range Quick Edit - ARB0OOO0
M.ame: Frequency:
|Aviation Band - VHF | 123.3000
Start: Stop: Step:
| 119.0000 | 136.0000 | 50.000
Mode: Attenuation: Uszer ID: Signal min: Signal max:
[aM_ =] [orr =z [none T |0 [255
Lockout: Delay ime: Dwell time: Time limit: Alarm:
Scan || [0 o |5 o
Comments:
Cancel Help

3. Thiswindow contains the properties for the selected Search Range.

4. Make any changes you wish, and press OK.

5. Any changes you have made will be reflected immediately.
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L ogging Output from Scanning

1. Begin scanning a group or a range.

2. Select the Scan List window and make sure that the L og column for the first entry in
the list is checked.

Scan List - Untitled I
Title:

Description:

Click on the hine number of the entry you wizh to change.

Type LOG
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Clear All Help Print

If it is not, click on the check box to activate it. When active, there will be an
X in the box.

3. Closethe Scan List window by clicking OK.
4. From the main scanning screen, select FILE, and click on Open Log. If thereis no

Open Log selection, click on Close Log, and then select FILE again. Open Log
should now appear.

11



5. A standard Windows file dialog will appear.

Open Log File | 7] |
File name: Folders:
I‘_Iud c:\trakstar

Cancel |
test_log i = ek A
=5 trakstar
(1 tsdist2 &l

List files of type: Dnves:
lASEII logs _'J | = c: ms-dos_b :_I New |

6. Enter afile namein the Open Log File dialog and press OK. Be sure not to use an
exigting filename.

7. Thelog fileis now active. Each time TrakkStar stops on a frequency, it will record an
entry in thefile. Hereis atypical listing from the aviation band:

120.6000 Aviation Band 2/12/96 08:47:20 00007 000017.3
121.7000 Aviation Band 2/12/96 08:47:23 00008 000000.7
118.3000 Aviation Band 2/12/96 08:48:48 00009 000002.0

Thefields are frequency, name, date, time, hit count and air time. If you have a

different type of radio, the listing will be similar, but may not include all of the fields
mentioned above.
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Creating an Active Frequency Journal

Journal Logging allows you to scan alarge number of channels, and create another Group
file that only contains the active frequenciesin your area. While active, TrakkStar will
create one entry for each active frequency in anew Group file, whose name you specify,
which can be loaded for scanning later. This powerful feature can allow you to find active
frequenciesin your area, without having to be present.

1. Begin scanning a group or a range.

2. Sedlect the Scan List window and make sure that the Journal column for the first
entry inthelist is checked.

Scan List - Untitled ]

Title:

Description:

Click on the ine number of the entry pou wizh to change.
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3. If itisnot, click on the check box to activate it. When active, there will be an X in the
box.

4. Closethe Scan List window by clicking OK.
5. From the main scanning screen, select FILE, and click on Open Journal. If thereis

no Open Jour nal selection, click on Close Jour nal, and then select FIL E again.
Open L og should now appear.
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6. A standard Windows file dialog will appear.

Open Journal File |
File name: Folders:

I‘_swd c:\irakstar

Cancel |
actvham.swyg A = ek a
h::ldllk-s'l'-‘g {25 trakstar Hel
cd.swg 1 tsdist? L‘

fire.zwg
gmrs. swq
iting.swg
ken.swg -
maritime._swq .j

Lizt files of type: Drives:
lEmups _‘ﬂ | =) ¢ me-dos_b :_I New |

7. Enter afile namein the Open Journal File dialog and press OK. Be sure not to use an
exigting filename.

8. The Journd fileis now active. Each time TrakkStar stops on a frequency, it will record
an entry in thefile.

9. When you want to stop storing active frequencies, select FILE, and click on Close
Journal.

10. The new frequency Group can now be loaded and scanned.
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Creating a Frequency List

So far, al of the frequencies we've used are from the samples included with TrakkStar. In
this example we will create a new frequency list with the Data M anager .

1. Double click on the Data Manager icon in the TrakkStar program group.

[Préss F1 for help, [Tue'Sep 81320

2. Click on the File menu, then select New and then Group.

15



3. A Create New Group dialog box will appear.

Create New Group |

Title for new group:
|Llntitled Group

HRadio type for new group:
AOR ARBO00 Hand Held Scanner =

Fleaze enter the number of channels and banks for this new
group. Remember, you can add or removye channelz and banks at
any hime.

Humber of channels in each bank: !5['
Mumber of banks: izﬂ

1]4 Cancel |

4. Givethegroup atitle, inthe Title for new group: field.

5. Theradio you are currently configured for will be listed in the section titled
Radio type for new group: .

6. Enter the number of channels per bank, and number of banks that you desire.
Y ou can always change these settings later, so if you don’t know exactly how many
you will need, you can leave them at the default settings.

7. Press OK to continue.
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8. A standard Windows dialog will appear, called New Group File Name.

Mew Group File Hame |

File name: Folders:
|‘.swg c:\trakstar
Cancel |
actvham.swqg - ek &
brdirk.swg £ trakstar
td-svg 1 tedist2
fire_swg L
QmrE. swg
itinz.swg
ken.swg -
marnitime. swag i
Save file az type: Drives:
|Emups j I =) c: ms-dos_b j

Select a name for the group. Be sure not to use an existing name.
9. Press OK to continue.

10. After a moment, the newly created Group window will appear.

g~ TrakkStar Data Manager EHEE
Fle Edit Charnel Fank Toole Locate Fadio Selings Help
Title: [Untitled Group | __HELP |
Info: | | ¥ Fixed
Edit: | = | meanesn|
ot MHz || STEP | OFFSET | IDENT IR | sYST | MAME
: TRUNE. | Bank [ [A] - Untitled bank. -
Al p.oooo 0.000] Wormal none | ilEmFﬂ‘," channel.
Al n.oooo 0.000] Normal none| .ilEl'l‘_lp_t_‘!.[‘ channel.
A2 0.0000 0.000| Wormal nOnE | i!l@m_pp.r channel.
A3 o.0000 0.000| Normal none| =|Empty channel.
Ad 0.0000 0.000| Wormal none| a|Empty channel.
AS n.0o0o 0.000] Wormal none| | =|Empty channel.
Ab 0.0000 0.000| Mormal none| _:]Emp_nt'g channel.
AT 0.0000 0.000| Wormal THERLE | a|Empty channel.
AB 0.0000 0.000| Normal none | = |Empty channel.
Al n.00oo 0.000| Normal ~ monge| {=|Empty channel.
AlD _0.0000 0.000| Wormal none | | =lEmpty channel.
A1 | 0.0000 0.000| Naormal none: =|Empty channel.
A2 | p.oooo 0.000| Wormal | none | = |Empty channel. =
FIm) SR

Sep B8 1557

|[Press Fi for heip.

The rows in thiswindow are channels, and the various columns are frequency, channel
number, name and other information.
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11. Double click on the first line under the M Hz column. The Edit box above will become
active, and the cursor will be in place, ready for you to enter afrequency.

12. After entering the frequency, press the TAB key to move across the grid until the
NAM E column is highlighted.

13. Enter aname for this channel and press ENTER.
14. Repeat steps 11 through 13 for additional channels, moving down aline each time.

15. When you are finished entering frequencies, click on File, and then Save.

18



|Creating a Search Range I

In this example you will create a new search range with the Data M anager .

1. If you are not already in Data Manager, start it by double clicking on the Data
Manager icon in the TrakkStar program group.

wStar Data Manager

[Press F1 forhelp, | [Tue Sep 81520

2. Click on the File menu, then click on New and then Sear ch range.

19



3. A Select Band dialog will appear.

Select Band I

0.000FK. to 90000 KHz - Fixed -
90.000K to 110,000 KHz - Loran-C Havigation System —
110.000K to 130.000 KHz - Havigation Beaconsz )
130_000K. to 160.000 KHz - Maritime Fixed

160.000K to 190,000 KHz - Fixed Stationsz

190_000K to 285.000 KHz - Aeronautical Beacons

285 000K to 335000 KHz - Mantime & Aeronautical Beacons

J335.000K to 415.000 KHz - Aeronautical Beacons

415 000K to 510.000 KHz - Maritime

510.000K to 530,000 KHz - Aeronautical Havigation

530.000K to 1625.000 KHz - Standard Broadcast Band

1625.000K. to 1800.000 KHz - Fixed & Mobile

1800.000K. to 1840.000 KHz - Amateur 160 Meters - CW/BTTY Subbabd
1840 000K to 2000000 KHz - Amateur 160 Meters - Phone Subband
2000_000K. to 2065.000 KHz - Fixed & Mobile

2065 000K to 2107.000 KHz - Mantime

2107_.000K. to 2170.000 KHz - Fixed & Mobile __‘ﬂ

Cancel |

Scroll through the list and select a band that is the same or close to what you want, and
then press OK.

4. A window with the band name as a title appears.

Aviation Communication - NONAME - ARS000
Title: |Aviation Communication =
Start:| 118.0000 Stop:| 136.0000
Stﬂp:.w Step: -W
Oftset: [Normal ldent: I
ID: [OMIT Towe]
Mode: [AM arrfort
Delay: |0 Tape:|Off
Alarm: |0 Dwell:|0 =

The controls in this window are the start, stop and step size, as well as other radio
specific settings.
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5. Make any changes to the fields in this window. Some fields are multiple choice fields,
and can be changed by simply clicking on the field. For example, Mode is amultiple
choice field which can be toggled though AM, FM, etc.

7. Click on the File menu, and then on Save As.

8. In the Save File dialog, enter a name for your new range and click OK.

Select Search Range |
File name: Folders:
I’.swl c:\trakstar

— Cancel |
aviation. swr | et -
baggage. swr 5] trakstar i
Qmrs_swi - 3 Help |
ham220_zwr 3 tsdist2
ham2metr_swr -
harr!lHI]_swr
marine. swr -
media_swr _ﬂ
List Files of type: Drives:
lHanges[‘.SWH] _‘j | =) c: me-dos_b :_I New
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Background Scanning

TrakkStar was designed to help you scan and use your PC for other tasks at the same
time.

If you wish, you can smply minimize the window, and continue scanning in the
background. However, if you wish to still have some controls available, do the following:

1. Start scanning something.
2. Click on Options, then Mini status window.

3. A small window will appear with four buttons. For now, move this window out of the
way somewhere on your screen.

Ch1. 85273750 5264

PAUSE| SCAM | LOCH | HIDE

4. Click on Options then Font selection then Mini status window.

5. A standard Windows font selection dialog box appears.

N -]

Font: Font style: Size:
Ihrial Regular iB | 1] 4 I
.’f[' Arial 4| [Regular al |8 .
:&' Arial Narrow ﬂ Italic ""! 9 il I
ri]:' Arial Rounded MT Bold Bold 10
' Book Antiqua Bold Italic 11
'_E Bookman Old Style 12
T Braggadocio 14
T Britannic Bold hd = e =l

-~ Sample

AaBbYyiz
Scnpt:
I‘w'estem :j
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6. Using the controlsin this dialog, select the smallest font that is readable on your
display. Arial, 8 point isa good starting point. If thisis too small, select a different font
or point size.

7. When you have a small font selected, press OK.

8. The text in the small window will change to the new font. Using the mouse, reduce the
size of the small window as much as possible to conserve screen space.

9. On the main scanning status window, press the minimize button (down arrow, upper
right corner).

10. At this point, scanning is taking place in the background, and you have almost all of
the desktop area available for running other Windows applications.

11. To remove the mini status window, click on it's HIDE button.
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Scanning Trunked Frequencies

Scanning trunked systemsis similar to conventional scanning, but additional steps are
necessary.

1. Double click on the Data M anager icon in the TrakkStar program group.
2. Click on the File menu, then click on New and then Group.
3. A Create New Group dialog box will appear.

Create New Group |

Title for new group:
|Llntitled Group

HRadio type for new group:
AOR ARBO00 Hand Held Scanner =

Fleaze enter the number of channels and banks for this new
group. Remember, you can add or removye channelz and banks at
any hime.

Humber of channels in each bank: !5['
Mumber of banks: izﬂ

1]4 Cancel I

4. Givethe group atitle, in the Title for new group: field.

5. Theradio you are currently configured for will be listed in the section titled
Radio type for new group: .

6. Enter the number of channels per bank, and number of banks that you desire.
Y ou can always change these settings later, so if you don’t know exactly how many
you will need, you can leave them at the default settings.

7. Press OK to continue.
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8. A standard Windows dialog will appear, called New Group File Name.

Mew Group File Hame |

File name:

|‘.swg

Folders:

c:\trakstar

actvham.swq
brdirk.swg
cd.zwg
fire_swg
QmrE. swg
itinz.swg
ken.swg
marnitime. swag

Save file az type:

ek
5 trakstar
(L] tedizt?

Drives:

|Emups

=

I =) c: ms-dos_b

H

Cancel |

Select a name for the group. Be sure not to use an existing name.

9. Press OK to continue.

10. After a moment, the newly created Group window will appear.

g~ TrakkStar Data Manager EHEE
Fle Edit Charnel Fank Toole Locate Fadio Selings Help
Title: [Untitled Group | __HELP |
Info: | | ¥ Fixed
Edit: | [ Canecel |
ot MHz || STEP | OFFSET | IDENT IR | sYST | MAME
: TRUNE | Bank D (A) - Untitled bank. ﬂ
Al p.oooo 0.000| Wormal none | ilEmFﬂ‘," channel.
Al n.oooo 0.000] Normal none| .ilEl'l‘_lp_t_‘!.[‘ channel.
A2 0.0000 0.000| Wormal nOnE | i!l@m_pp.r channel.
A3 o.0000 0.000| Normal none| =|Empty channel.
Ad 0.0000 0.000| Wormal none| a|Empty channel.
AS n.0o0o 0.000] Wormal none| | =|Empty channel.
Ab 0.0000 0.000| Mormal none| _:]Emp_nt'g channel.
AT 0.0000 0.000| Wormal THERLE | a|Empty channel.
AB 0.0000 0.000| Normal none | = |Empty channel.
Al n.00oo 0.000| Normal mane | {=|Empty channel.
AlD _0.0000 0.000| Wormal none | | =lEmpty channel.
A1 | 0.0000 0.000| Naormal none: =|Empty channel.
A2 | p.oooo 0.000| Wormal | none | = |Empty channel. =
FIm) SR

|[Press Fi for heip.

Sep B8 1557

The rows in this windows are channels and the various columns are
frequency, channel number, name and other information.
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11. Double click on the first line under the M Hz column. The Edit box above will become
active, and the cursor will be in place, ready for you to enter afrequency.

12. After entering the frequency, press the TAB key to move across the grid until the
NAM E column is highlighted.

13. Enter aname for this channel and press ENTER.
14. Press the TAB key until the" SYS" column is highlighted.

15. Click in the edit box until the desired system type is shown. For trunking, this should
beTypel, Typell or LTR.

16. Repeat steps 5 through 11 for each additional trunk group channel.

17. Scroll up to the top of the group. Click on the TRUNK button located in the bank
header above the frequencies you just entered. A pop-up menu will appear.

Fleet Map - Bank A - Untitled bank. i

Taystem fype Enter fleet map size codes for this bank. Mote that

" Non-trunked " Typell 5-12 can only be assigned to Blocks 0. 2. 4 or 6.
%-13 can only be azzigned to Blocks 0 and 4, and

& Type I: CLTR 5-14 can only be aszigned to Block 0. Pleasze refer to
the BC-895<LT appendiz for more information on

programming user defined fleet maps.

Double click on the zize code you want to change.

Block Size Code Fleets | Sub Fleets ID=s Blocks Used

1] 5-0 - - - 1
1 5-0 1
2 5-0 1
3 5-0 1
4 5-0 1
5 5-0 1
6 5-0 1
i 5-0 1

‘ ‘ Convert to Type |

Cancel Help Print
Convert to Type 1l

Select Fleet map and system type. In the System type: section, which isin the upper
left section, select the proper type of system, Typel, Typell or LTR. Note that the
system type selected here MUST be the same as the type selected for each channel.

18. Click OK to exit the dialog box.
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19. Tofinish, select File, then Save.
20. To scan this group, select it into the Scan List during scanning.

21. During scanning of this trunk group, talk group 1D codes will appear in the ID field.
To add IDsto the ID scan list, pressthe ADD ID button. The 1D scan list is used for
limiting which talk groups you want to scan. It only has an effect when Closed M ode
isactive. If you only want to lock onto one group, just click ID HOL D whenever you
hear something you want to follow, and then click SCAN to resume normal scanning
of all talk groups.
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Frequently Asked Questions (FAQ)

Why do | haveto createfilesfor frequency lists and search ranges? Why can't | just
enter them directly while scanning?

TrakkStar uses files to store all scanning data so that related information can be stored and
manipulated as a single object. While this may seem more complicated, the payoff isin
functionality. For example, a search range file ((SWR) contains not only the search range,
but also contains the radio settings, lock out list and the last twenty log reports.

What does the 9B0O0 error mean?
Thisis acommon problem, and indicates that TrakkStar is unable to establish reliable

communication with your radio. Refer to the help section Troubleshooting Radio
Connections in TrakkStar help.

28



